LING 380: Acoustic Phonetics
Lab Manual

Sonya Bird
Qian Wang
Sky Onosson
Allison Benner

Department of Linguistics
University of Victoria
INTRODUCTION

This lab manual is designed to be used in the context of an introductory course in Acoustic Phonetics. It is based on the software Praat, created by Paul Boersma and David Weenink (www.praat.org), and covers measurement techniques useful for basic acoustic analysis of speech. LAB 1 is an introduction to Praat: the layout of various displays and the basic functions. LAB 2 focuses on voice onset time (VOT), an important cue in identifying stop consonants. The next several labs guide students through taking acoustic measurements typically relevant for vowels (LAB 3 and LAB 4), obstruents (LAB 4) and sonorants (LAB 6 and LAB 7). LAB 8 discusses ways of measuring phonation. LAB 9 focuses on stress, pitch-accent, and tone. LAB 9 and LAB 10 bring together the material from previous labs in an exploration of cross-dialectal (LAB 10) and cross-linguistic (LAB 9) differences in speech. Finally, LAB 11 introduces speech manipulation and synthesis techniques.

Each lab includes a list of sound files for you to record, and on which you will run your analysis. If you are unable to generate good-quality recordings, you may also access pre-recorded files. Each lab also includes a set of questions designed to ensure that you – the user – understand the measurements taken as well as the values obtained for these measurements. These questions are repeated in the report at the end of the lab, which can serve as a way of recapitulating the content of the lab.

The lab manual is a work in constant progress. If you have any feedback, please feel free to email Sonya Bird at sbird@uvic.ca
## Table of Contents

LAB 1 – EXPLORING PRAAT ........................................................................................................... 1  
LAB 1 Report – Exploring Praat ................................................................................................. 11

LAB 2 – VOICING IN STOP CONSONANTS ............................................................................... 12  
LAB 2 Report – Voice Onset Time (VOT) ..................................................................................16

LAB 3 – VOWEL PROPERTIES ................................................................................................. 18  
SECTION I. Intrinsic pitch ..........................................................................................................18  
SECTION II. Spectral make-up (formant values) .......................................................................21  
LAB 3 Report – Vowel Properties ..............................................................................................24

LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH: FUNDAMENTAL FREQUENCY, HARMONICS AND FORMANTS .................................................................................................................. 25  
SECTION I. Fundamental frequency ($F_0$) or Pitch ................................................................. 25  
SECTION II. Harmonics .............................................................................................................. 28  
SECTION III. Formants .............................................................................................................. 29  
SECTION IV. The relationship between harmonics and formants ..............................................31  
LAB 4 Report – The Source-Filter Model of Speech ................................................................. 32

LAB 5 – OBLIQUE PLACE OF ARTICULATION ...................................................................... 34  
SECTION I. Stop consonants ...................................................................................................... 34  
SECTION II. Fricatives ................................................................................................................35  
LAB 5 Report – Oblique Place of Articulation ...........................................................................38

LAB 6 – GLIDES AND LIQUIDS ............................................................................................... 39  
SECTION I. Glides ...................................................................................................................... 39  
SECTION II. Liquids .................................................................................................................. 40  
LAB 6 Report – Glides and Liquids ............................................................................................43

LAB 7 – NASALS ......................................................................................................................... 45  
LAB 7 Report – Nasals ................................................................................................................48

LAB 8 – PHONATION TYPES ..................................................................................................... 49  
LAB 8 Report – Phonation Types ...............................................................................................57

LAB 9 – STRESS, PITCH ACCENT, TONE ............................................................................... 58  
SECTION I. English stress ......................................................................................................... 58  
SECTION II. Japanese pitch accent ............................................................................................60  
SECTION III. Mandarin Tone ......................................................................................................60  
LAB 9 Report – Stress, Pitch Accent, Tone .................................................................................62

LAB 10 – PROSODY AND RHYTHM ...................................................................................... 65  
SECTION I. Prosody: question intonation in English vs. Skwxwú7meshí ...........................................65  
SECTION II. Rhythm across dialects of English ..........................................................................66  
Optional extra section on dialects of English ..............................................................................69  
LAB 10 Report – Prosody, Rhythm .............................................................................................71

LAB 11 – SPEECH SYNTHESIS ............................................................................................... 73  
SECTION I. Voicing Manipulation ..............................................................................................73  
SECTION II. Tone manipulation .................................................................................................78  
SECTION III. Rap Song ...............................................................................................................80  
LAB 11 Report – Speech Synthesis ............................................................................................81
LIST OF FIGURES

Figure 1.1 Praat icon........................................................................................................ 1
Figure 1.2 Praat layout.................................................................................................... 1
Figure 1.3 Recording a mono sound ............................................................................. 2
Figure 1.4 Clipped signal .............................................................................................. 3
Figure 1.5 A crowded edit window .............................................................................. 4
Figure 1.6 Editing a sound file...................................................................................... 5
Figure 1.7 Creating a textgrid ..................................................................................... 6
Figure 1.8 Opening a textgrid file with its corresponding sound file........................... 7
Figure 1.9 Segmenting and labeling .......................................................................... 8
Figure 1.10 Example of Word output ......................................................................... 9
Figure 2.1 Positive and negative VOT measurement .................................................. 13
Figure 2.2 Voice bar and VOT measurement ................................................................ 15
Figure 3.1 Getting a pitch value in Praat .................................................................. 19
Figure 3.2 Creating a pitch chart in Excel and Word .................................................. 20
Figure 3.3 Formants .................................................................................................... 21
Figure 3.4 Creating a vowel space chart in Excel ....................................................... 23
Figure 4.1 Getting a pitch value in Praat .................................................................. 26
Figure 4.2 Calculating pitch by waveform .................................................................. 27
Figure 4.3 Harmonics .................................................................................................. 28
Figure 4.4 Formant ...................................................................................................... 31
Figure 5.1 Formant transition from the stop to the following vowel ......................... 35
Figure 5.2 Fricative spectral analysis ........................................................................ 36
Figure 6.1 Formant transition in onset position ....................................................... 41
Figure 6.2 Formant transition in coda position .......................................................... 42
Figure 7.1 Nasal waveform ....................................................................................... 46
Figure 7.2 Antiformants ............................................................................................. 47
Figure 8.1 Measurement point .................................................................................. 50
Figure 8.2 Jitter measurement ................................................................................... 51
Figure 8.3 Jagged peaks ............................................................................................ 52
Figure 8.4 Acoustic intensity ..................................................................................... 53
Figure 8.5 Measuring spectral tilt, zoomed-out view ................................................ 54
Figure 8.6 Measuring spectral tilt, zoomed-in view ................................................... 55
Figure 8.7 Duration measurement .......................................................................... 56
Figure 9.1 Measuring mean pitch and intensity in Praat ........................................... 59
Figure 9.2 Tone measurement in Mandarin ............................................................... 61
Figure 10.1 Segmenting a sound file into CV sequences ........................................... 67
Figure 10.2 Plotting rhythm as a function of %V and delta-C .................................... 69
Figure 11.1 VOT manipulation ............................................................................... 74
Figure 11.2 Duration manipulation .......................................................................... 77
Figure 11.3 Pitch manipulation ............................................................................... 79
# List of Measurements

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude</td>
<td>53–54</td>
</tr>
<tr>
<td>Antiformants</td>
<td>47</td>
</tr>
<tr>
<td>Duration</td>
<td>57</td>
</tr>
<tr>
<td>Formants</td>
<td>29–30</td>
</tr>
<tr>
<td>Fundamental frequency (F0)</td>
<td>25–27</td>
</tr>
<tr>
<td>Harmonics</td>
<td>28–29</td>
</tr>
<tr>
<td>Jitter</td>
<td>51–53</td>
</tr>
<tr>
<td>Spectral tilt</td>
<td>54–56</td>
</tr>
<tr>
<td>Voice bar</td>
<td>14</td>
</tr>
<tr>
<td>VOT</td>
<td>13</td>
</tr>
</tbody>
</table>
LAB REPORTS

Each lab includes a report section. Numbered questions (e.g. Q1) to be answered in the report are listed throughout the lab, and repeated in summary in the report section.

The goal of the lab reports is for you to practice doing the kind of phonetic analysis that is done in the field of phonetics. This includes doing the acoustic analysis itself (in Praat) and also presenting and interpreting your acoustic analysis.

Lab reports are designed in similar ways, though obviously the details of what you will be reporting on are lab-specific. The expectation is that you will write up your reports in Word, and incorporate into them the Tables provided for you at the end of each lab, as well as illustrative screen shots from Praat and figures from Excel (as appropriate).

An example of incorporating a Praat figure in Word is covered in Lab 1 – Exploring Praat, in Figure 1.10 Example of Word output, and instructions for creating an Excel chart and incorporating it into Word are shown in Lab 3 – Vowel Properties in Figure 3.2 Creating a pitch chart in Excel and Word.

An additional component of each lab is to include a summary of one academic reference related to the lab material. The goal of this component is for you to gain an appreciation for the kind of research that uses the methods and analysis tools that you are learning about.

Each lab should be submitted electronically via Coursespaces.
LAB 1 – EXPLORING PRAAT

GOAL OF LAB 1
The goal of this first lab is to explore some of the basic features of Praat (www.praat.org), which we will be using for speech analysis throughout the term. You will learn to make recordings, bring up visual displays of these recordings (waveforms and spectrograms), segment and label various components of these recordings, and export the visual displays into a word document. The skills you learn today will be useful for your lab work throughout the remainder of this course and beyond…

1. Open Praat: double click on the following icon (Figure 1.1):

![Figure 1.1 Praat icon](image1)

2. Get to know the Praat layout (Figure 1.2)

![Figure 1.2 Praat layout](image2)
The tools you see in the Analysis and Synthesis Tool Panel (see Figure 1.2 above) are specific to the highlighted object(s) in the list. For example, the tools that are listed for a sound object are different from that for a Textgrid object. When you first open Praat, there will be nothing in your object list. As a result, nothing will show up in your Analysis and Synthesis Tool Panel.

3. Record the sentence: “My name is [first-name] [last-name]”
   - In the main menu of the Objects window (see Figure 1.2):
   - New > Record mono Sound (sampling rate: 44 100 Hz) (Figure 1.3)
   - Make sure the volume bar is fluctuating as you record — if it isn’t, you’re not recording; if you don’t see the volume bar at all, you’re not speaking loudly enough.
   - Watch out for clipping (Figure 1.4): if your recording level is too high and you go into the red on the volume bar, you’ll end up with what is called a “clipped” signal — this is very bad for speech analysis!
   - Give the recording a name (in the box below “Save to list”)
   - Save to list

Figure 1.3 Recording a mono sound

---

1 What is a Textgrid object? See step 8 below.
Figure 1.4 Clipped signal

Compare the waveform in these two cases. The one in the clipped recording has a square-like form.
4. Open the sound file in the Edit window:
   
   o In the Objects window (see Figure 1.2), highlight the sound file you’ve just recorded.
   o Click View & Edit on the “Analysis and synthesis tools” panel (see Figure 1.2).

When you first open a sound file in the View & Edit window, it may seem a bit of a mess. Depending on the default settings in the version of Praat you are using, you may see blue vertical lines in the waveform, and lines of red dots and a blue line in the spectrogram (see Figure 1.5). If you don’t need these displays for your current purposes (you don’t for this lab!), you can tidy up the visual display by doing the following: in the menu of the View & Edit window:

   o **Pulses > Show pulses** (click on this to unselect it)
   o **Formant > Show formants** (click on this to unselect it)
   o **Pitch > Show pitch** (click on this to unselect it)

Two things are being displayed now in the Edit window: the **waveform** on the upper level and the **spectrogram** on the lower level.
TIP Here are some common manipulations you will find useful:

Selecting a portion of the sound file and measure the duration of the portion
- To select a portion of the sound file, place the cursor on the starting point on the waveform or spectrogram and drag the mouse over the portion you are interested in.
- The number in black at the top and bottom of the display indicates the duration of the selection. The two red numbers on each side of the selection (on the top only) indicate the starting and ending time of the selection (see Figure 1.6).

Zooming into a portion of the sound file
- To zoom into a specific portion of the sound file, select it first and click “sel” in the zoom options panel (see Figure 1.6).
- You can also use the “in” and “out” buttons in the zoom options panel to zoom in or zoom out within the sound file. This will zoom the file around the center point of the window display, regardless of where your cursor is.

Listening to a sound file
- In the View & Edit Window, you can listen to the sound file or a portion thereof by clicking on one of the panels at the bottom of the display (Figure 1.6).

5. Extract [first-name last-name]
- Select the portion that corresponds only to your first and last name (see Figure 1.6)
- File > Extract selected sound (time from zero) (The extracted selection will show up as an entry (‘sound untitled’) in the Praat objects window)
- Close View & Edit window

Figure 1.6 Editing a sound file
6. Rename the extracted file (‘sound untitled’ in the Praat objects window)
   - In the Objects window, highlight ‘sound untitled’
   - Click Rename below the object list

7. Save the new sound file on the desktop:
   - Highlight the file in the object list
   - Save > Save as WAV file… (this is the most widely acceptable extension)
   - Select the desktop as the save-to location

8. Create a textgrid

Textgrids let you label or annotate the spectrogram (and sound file) – they are particularly helpful for acoustic analysis, to keep track of where you’ve taken measurements, etc.

   - In the Praat Objects window, highlight the newly renamed file (see step 6)
   - Annotate > To TextGrid… (see Figure 1.7)
   - Create two tiers (this will be enough for our purposes): All Tier names: word segment

Figure 1.7 Creating a textgrid

---

2 This creates 2 tiers, one with the name of ‘word’ and the other with the name of ‘segment’. Ignore the second line in the TextGrid naming window “Which of these are point tiers”. This is irrelevant at the present stage.
LAB 1 – EXPLORING PRAAT

9. Open the sound file and textgrid together: (see Figure 1.8)

In order to segment and/or label a sound file, you have to open the sound file TOGETHER with its textgrid file.

- Hold down Ctrl (or Command on a Mac) and click on each file to highlight them both
- View & Edit

![Figure 1.8 Opening a textgrid file with its corresponding sound file](image)

In your display you should now see the waveform (top), the spectrogram (middle) and the textgrid (bottom) corresponding to your sound file (see Figure 1.9). We will talk about waveforms and spectrograms in detail later on.

10. Segment the file (see Figure 1.9)

In the sound file, identify your first name and last name. Use the following steps to segment each:
To find your first and last name on the spectrogram, listen to the sound file and look at the spectrogram – these should give you hints as to where your first name ends and your second name and starts. It may help to zoom into small chunks of the sound file and listen to those.

Place the cursor at the beginning of the name on the spectrogram/waveform (not on the Textgrid tier). A boundary line will show up.

Click in the little circle at the top of the word tier in the Textgrid to create a boundary (Figure 1.9).

To remove a boundary that you have made,

Highlight the boundary

Go to Boundary > Remove OR click Alt+backspace

To move a boundary,

Highlight the boundary by clicking on it (it should go red) and drag it.

11. Label the intervals (see Figure 1.9)

Select/highlight the target interval by clicking between two boundaries, the selected the interval should go yellow.

To input or change the text in an interval, edit in the Textbox above the spectrogram (See Figure 1.9).

Give each interval you create a name ([first name] or [last name])
12. Follow steps (10) and (11) to segment your [first name + last name] into segments.

**TIP** To use phonetic symbols in your segment tiers,
- In the TextGrid editing window, go to Help > Phonetic symbols
- From here you can see what keystrokes you need to create special fonts (using them is not recommended because they end up looking a bit wonky…)

13. Save your textgrid onto the desktop:
   - **File > Save TextGrid as textfile…**

14. Export your labeled waveform and spectrogram to Word (see Figure 1.10):
   - Maximize the Edit window: click on the little square at the top right of your Edit window
   - Hit **PrtSc** (“Print Screen”) on your keyboard³. Nothing will happen on your screen at this point.
   - Open Word, and provide a prose introduction to the image you are about to paste in: e.g. “Figure 1 is a waveform and spectrogram of my name”
   - Hit **Ctrl+V** to paste the Praat image into your word document.

---

³ Note: this works on a PC. On a MAC: Command-shift-3. By doing this, you are actually copying what you see on the screen to a clipboard, although it seems that nothing has happened.
15. Save the file: you must upload it to the CourseSpaces site.

If you complete all of these steps, you should end up with a word file with an image of the labeled waveform/spectrogram corresponding to your name, as in Fig. 1.10. You can save this file, and your Praat files (sound and textgrid) by e-mailing them to yourself or copying them onto a flash drive (memory stick).
LAB 1 – EXPLORING PRAAT

LAB 1 REPORT – EXPLORING PRAAT

Your lab report should include one Figure, corresponding to the segmented and labeled spectrogram/waveform of your name. In addition, please answer the following questions:

Q1: How can you tell where one word ends and another word begins?

Q2: Do you notice any patterns in terms of how different sounds look visually, on either the waveform or the spectrogram?

   a. Which sounds have the highest amplitude and how can you tell?
   b. How do sounds of different sonority (e.g. stop vs. fricative) look on the spectrogram?
LAB 2 – VOICING IN STOP CONSONANTS

GOAL OF LAB 2
One of the most common acoustic features that is measured and manipulated in speech research is voicing in stop consonants (in particular voice onset time), so this is a good place to start. In this lab, we are going to explore the acoustic correlates of different stop consonants in terms of two parameters: VOICING and PLACE OF ARTICULATION.

RECORDING
Generate the following sound files, containing the sound sequences listed.

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab2_Eng_stop_a.wav</td>
<td>pʰa, ba, tʰa, da, kʰa, ga</td>
</tr>
<tr>
<td>Lab2_Eng_a_stop_a.wav</td>
<td>apʰa, aba, atʰa, ada, akʰa, aga</td>
</tr>
<tr>
<td>Lab2_Eng_a_stop.wav</td>
<td>lap, lab, bat, bad, rack, rag</td>
</tr>
</tbody>
</table>

If you are a fluent French speaker, also generate the following sound files. Otherwise, you can go to the CourseSpaces site and download the zip file Lab2_SoundFiles, which contains these files.

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab2_Fr_stop_a.wav</td>
<td>pʰa, ba, tʰa, da, kʰa, ga</td>
</tr>
<tr>
<td>Lab2_Fr_a_stop_a.wav</td>
<td>apʰa, aba, atʰa, ada, akʰa, aga</td>
</tr>
<tr>
<td>Lab2_Fr_a_stop.wav</td>
<td>lap, lab, bat, bad, rack, rag</td>
</tr>
</tbody>
</table>

Three important acoustic correlates of voicing in English stops are the voice bar, VOT, and the duration of the preceding vowel. For each of the stops in the file, take the three measurements according to the instructions below and fill out Table 2.1, Table 2.2 and Table 2.3 accordingly. Answer the related questions by comparing your measurements across stops.

1. Open the following sound files in Praat: Eng_stop_a.wav and Fr_stop_a.wav. Measure the VOT of each stop (see Figure 2.1) and fill in Table 2.1. Compare voiced/voiceless counterparts (p/b, t/d, k/g):

   - Zoom in so that you can clearly see the transition between the stop and vowel
   - Measure the time between the end of the stop closure (= the beginning of the release burst) and the onset of voicing (= the onset of regular pitch pulses in the waveform). This is voice onset time, or VOT.

     - If the onset of voicing follows the release of the stop closure, then VOT is calculated as positive; stops with positive VOT are termed voiceless. (See top of Figure 2.1)
     - VOTs between 0-20ms correspond to voiceless unaspirated stops
     - VOTs above this correspond to voiceless aspirated stops

4 Prat reports time values in seconds, but in phonetic analysis we report in milliseconds, so the values need to be converted. Once you have converted to milliseconds, you do not need to report any decimal places.
- If the onset of voicing precedes the release of the stop closure, then VOT is calculated as negative; stops with negative VOT are termed prevoiced (or more generally voiced). (See bottom of Figure 2.1)

![Image of waveforms showing VOT measurement]

**Figure 2.1 Positive and negative VOT measurement**
Lab 2 – Voice Onset Time (VOT)

Q1: Based on your VOT measurements, what does the voicing contrast correspond to phonetically (refer to terms provided above), in each language? Is it the same in French and in English?

2. Open the following sound files in Praat: Eng_a_stop_a.wav and Fr_a_stop_a.wav. Note down the presence vs. absence of the voice bar (see Figure 2.2) during the stop closure of each consonant in Table 2.2 in the report.

Q2: If the voice bar is present at all, does it last through the duration of the closure? Why do you think it might go away?

Q3: What differences (if any) do you observe in the voice bar between English and French?

3. Open the following sound files in Praat: Eng_a_stop.wav and Fr_a_stop.wav. Measure the duration of the vowel preceding each stop, and fill in Table 2.3 in the report. Compare vowel durations in the voiced vs. voiceless series.

TIP In order to measure the duration of the vowel, you will need to identify the section of the spectrogram which makes up the vowel. One common means of doing so is to measure where there are clearly visible vowel formants (see Lab 4, p. 29). Whatever method you do use, the most important thing is to be consistent and use the same method for all your measurements.

Q4: How does the duration of the preceding vowel differ depending on the voicing of the following consonant?

Q5: What differences (if any) do you observe in the preceding vowel duration between English and French?

Q6: Summarizing what you’ve seen in this lab, what are the possible acoustic correlates of the phonemic voicing (voiced vs. voiceless) contrast across languages?
Figure 2.2 Voice bar and VOT measurement
Table 2.1 VOT

<table>
<thead>
<tr>
<th></th>
<th>pʰ</th>
<th>b</th>
<th>tʰ</th>
<th>d</th>
<th>kʰ</th>
<th>g</th>
</tr>
</thead>
<tbody>
<tr>
<td>English VOT (ms)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Eng_stop_a)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>French VOT (ms)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Fr_stop_a)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Q1:** How does VOT differ in voiced vs. voiceless stops and what explanation can you come up with for this?

Table 2.2 Voice bar

<table>
<thead>
<tr>
<th></th>
<th>pʰ</th>
<th>b</th>
<th>tʰ</th>
<th>d</th>
<th>kʰ</th>
<th>g</th>
</tr>
</thead>
<tbody>
<tr>
<td>English voice bar</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Eng_a_stop_a.wav)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is it there?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How long does it last?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>French voice bar</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Fr_a_stop_a.wav)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is it there?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>How long does it last?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Q2:** If the voice bar is present at all, does it last through the duration of the closure? Why do you think it might go away?

**Q3:** What differences (if any) do you observe in the voice bar between English and French?

Table 2.3 Preceding V duration

<table>
<thead>
<tr>
<th></th>
<th>pʰ</th>
<th>b</th>
<th>tʰ</th>
<th>d</th>
<th>kʰ</th>
<th>g</th>
</tr>
</thead>
<tbody>
<tr>
<td>English preceding V duration (ms)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Eng_a_stop)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>French preceding V duration (ms)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Fr_a_stop)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Q4:** How does the duration of the preceding vowel differ depending on the voicing of the following consonant?
LAB 2 – VOICE ONSET TIME (VOT)

Q5: What differences (if any) do you observe in the preceding vowel duration between English and French?

Q6: Summarizing what you’ve seen in this lab, what are the possible acoustic correlates of the phonemic voicing (voiced vs. voiceless) contrast across languages?

REFERENCES

Q7: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
In this lab, we are going to explore vowel properties: INTRINSIC PITCH and SPECTRAL MAKE-UP (FORMANT STRUCTURE).

RECORDING
Generate the following a single sound file (Lab3_EnglishVowels) containing one repetition each of the following words: beat, bit, bait, bet, bat, boat, but, boot (see Lab1, p.1). Try to use a level (monotone) pitch throughout each of the vowels. (This will be easiest if you pause between vowels, rather than uttering the sequence of vowels as if it were part of a sentence.)

Take a quick look at your vowels in the View & Edit window, and make sure you can clearly see the vowel formants (see Lab1 on formant display, p.4). If you have trouble seeing them, you can download the file Lab3_EnglishVowels.wav from the CourseSpaces site and take your measurements on this file. If you do this, please make a note of it on your report.

1. Which vowels are contained in these words? Fill in the appropriate IPA symbols on the top row in each of Table 3.1 and Table 3.2.

Q1: In this lab, you should take all of your measurements in approximately the same spot: what spot do you think is best, and why?

SECTION I. INTRINSIC PITCH

2. Measure the pitch (F0) in each of the vowels (see Figure 3.1). Note down your measurements in Table 3.1. Note that measurements should be rounded to the nearest whole number “unité” – no decimal points!

- Display the pitch track: Pitch > Show pitch
- Click on the blue pitch track in the middle, stable portion of the vowel
- A red horizontal bar should appear, with the pitch value (dark blue) on the right side of the window: note down this value in Table 3.1.

Note that the Fundamental frequency value is always displayed on the right side of the window in dark blue; formant frequencies are displayed on the left side in red – be careful not to get these two confused! If the blue pitch contour (blue line) doesn’t appear clearly, it is because Praat’s default pitch range is not appropriate for the file you’re listening to:

- go to Pitch > Pitch settings…
- adjust the pitch range so you can see the pitch contour clearly:
  - If you have a very high voice you may need to adjust the range upwards.
  - If you have a very low voice you may need to adjust the range downwards.
LAB 3 – VOWEL PROPERTIES

Figure 3.1 Getting a pitch value in Praat

**TIP** If you are male, your pitch ought to be somewhere between 90 Hz and 150 Hz. If you are female, it should be somewhere between 150 Hz and 250 Hz. If the pitch values that you are getting are outside of these ranges, Praat might be making a measurement error. You can confirm your pitch measurement by zooming in to a very small section of the waveform and manually measuring the duration of one glottal cycle. See Lab 4 for further details.

3. Use the confirmed pitch values from Table 3.1 to generate a chart in Excel.

   o Open a new spreadsheet in Excel: enter the IPA symbols for each vowel in column A, and your pitch (F0) measurements in column B (see Figure 3.2)
   o Select (highlight) columns A and B and create a chart: **Insert > Clustered column**
   o Copy and paste both the table of measurements and the chart into a Word document for your lab report
Figure 3.2 Creating a pitch chart in Excel and Word
**LAB 3 – VOWEL PROPERTIES**

**Q2**: Is pitch the same across all vowels? Do you notice any patterns with it? If so, what do you think the articulatory basis of these patterns might be?

**SECTION II. SPECTRAL MAKE-UP (FORMANT VALUES)**

4. Now focus on the spectrogram and measure the first and second formants (F1 and F2) of each vowel (see Figure 3.3). Enter the obtained values in Table 3.2. Note that measurements should be rounded to the nearest whole number – no decimal points!

- Display the formant track: **Formant > Show formants**
- Place your cursor in the centre of each formant, in the middle of the vowel
- A red horizontal bar should appear, with the frequency value on the left side of the window, in red

**TIP**  It is not always easy locating formants. Don’t get discouraged, just do the best you can!

![Figure 3.3 Formants](image-url)
5. Enter the formant values into the Excel spreadsheet you created in 3 above, and create your vowel plot (see Figure 3.4).

- Calculate and enter the value of F2-F1 for each vowel in column C, and enter the F1 value in column D. (Note, you can use excel to calculate F2-F1 automatically).
- Select (highlight) columns C and D and create a scatterplot: Insert > Scatter
- Reverse the order of both axes by right-clicking on each axis to open Format Axis: and check the box beside Values in reverse order
- Double-click on the plot title and enter Vowel Space
- Create the titles F2-F1 for the x-axis and F1 for the y-axis: Chart Design > Add Chart Element > Axis Titles
- Create labels for your data points: Right-click on any datapoint in the plot and select Add Data Labels
  - By default, the labels will display the y-axis value (F1); click on the displayed value and re-enter the applicable IPA vowel symbol

**TIP** It can be somewhat tricky to click precisely on the data label; try increasing the zoom level of the display to 150 or 200%

Copy and paste your chart and data into your lab report as in Section I (p. 18).
**LAB 3 – VOWEL PROPERTIES**

![Figure 3.4 Creating a vowel space chart in Excel](image)

**Q3:** Look at the formant values associated with different vowels:
   a. Why do formants differ across vowels?
   b. What does F1 seem to correspond to, in terms of articulation?
   c. What about F2?

**Q4:** Does your vowel chart look as you expected that it would, based on similar ones you may have encountered in your previous courses/textbook(s)? Note anything that strikes you about your vowel chart as being unusual, or different from your expectations.
LAB 3 REPORT – VOWEL PROPERTIES

SECTION I. INTRINSIC PITCH

Q1: In this lab, you should take all of your measurements in approximately the same spot: what spot is this and why?

Table 3.1 Intrinsic vowel pitches (F0)

<table>
<thead>
<tr>
<th>Method</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual measurement</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q2: Is pitch the same across all vowels? Do you notice any patterns with it? If so, what do you think the articulatory basis of these patterns might be?

SECTION II. SPECTRAL MAKE-UP (FORMANT VALUES)

Table 3.2 Vowel formants

<table>
<thead>
<tr>
<th>Formant</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
<th>[ ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 (Hz)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F2 (Hz)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q3: Look at the formant values associated with different vowels:
   a. Why do formants differ across vowels?
   b. What does F1 seem to correspond to, in terms of articulation?
   c. What about F2?

Q4: Does your vowel chart look as you expected that it would, based on similar ones you may have encountered in your previous courses/textbook(s)? Note anything that strikes you about your vowel chart as being unusual, or different from your expectations.

REFERENCES

Q5: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH:
FUNDAMENTAL FREQUENCY, HARMONICS AND FORMANTS

GOAL OF LAB 4
The goal of this lab is to explore the relationships between FUNDAMENTAL FREQUENCY, HARMONICS, and FORMANTS, as explained by the Source-Filter model of speech. Understanding these relationships is crucial to understanding the properties of the complex wave that is associated with the speech signal.

RECORDING
Generate a single sound file (Lab4_SourceFilter.wav) containing the vowel [ɛ] produced at three different pitches: low, mid, high – try to get the biggest range in pitch you can (if you can’t remember how to record yourself, refer to LAB1).

SECTION I. FUNDAMENTAL FREQUENCY (F₀) OR PITCH

1. Measure the fundamental frequency (pitch) in the middle of each [ɛ], using the three techniques described below, and fill out Table 4.1.

Three ways to measure fundamental frequency:

a. By displaying the pitch track and having Praat measure the pitch automatically (see Figure 4.1; this is the technique you used in Lab 3):

   - Display the pitch track: Pitch > Show pitch
   - Place your cursor in the middle, stable portion of the vowel
   - Go to Pitch > Get pitch: a box will appear with the pitch value in it.

b. By displaying the pitch track and measuring pitch manually (see Figure 4.1):

   - Display the pitch track: Pitch > Show pitch
   - Click on the blue pitch track in the middle of the vowel
   - A red horizontal bar should appear, with the pitch value (in dark blue) on the right side of the window.

TIP The Fundamental frequency value is always displayed on the right side of the window in dark blue; formant frequencies are displayed on the left side in red – be careful not to get these two confused!
By looking at the waveform (top of the display) (see Figure 4.2)

- Zoom in to a small piece of the waveform in the middle of the vowel and measure the period by highlighting one complete cycle, going from zero-crossing to zero-crossing, and noting the time associated with it (in the panel above the waveform)
- To get the frequency ($f$) from the period ($T$): $f = \frac{1}{T}$
**LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH**

**TIP** You can get Praat to place the cursor at the nearest zero-crossing by using the hotkey Ctrl-0 (zero), or Command-0 on a Mac. Additionally, if you highlight a section of a waveform, the hotkeys Ctrl/Command-, and Command-. will move the left and right edges of the selection, respectively, to the closest zero-crossing.

If you zoom in enough, the panel above the waveform will include both the period and the frequency (in parentheses), so you don’t have to do any calculations.

![Image showing how to calculate pitch by waveform](image)

**Figure 4.2 Calculating pitch by waveform**

**Q1:** Which method do you prefer and why?
SECTION II. HARMONICS

When our vocal folds vibrate, the result is a complex wave, consisting of the fundamental frequency (which you just measured) plus other higher frequencies, called harmonics. To see these, we need to look at a narrow-band spectrogram, which is more precise along the frequency domain than the default wide-band spectrogram.

2. Display a narrow-band spectrogram:

   - Go to: **Spectrum > Spectrogram settings…** (see Figure 4.3)
   - Change the window length to 0.025s (see Figure 4.3)
     (The default is window length is 0.005s, which displays a wide-band spectrogram)
     → This changes the spectrogram dramatically!

Note: the narrow-band and wide-band spectrograms illustrate the time/frequency trade-off. A spectrogram can have very high resolution in frequency (narrow-band) or in time (wide-band), but not in both!

![Figure 4.3 Harmonics](image-url)

- Harmonics that are darker = formants
- A red horizontal bar should appear, with the frequency value on the left side of the window
- Change window length to 0.025
- H1: the first harmonic
- H2
- H10
LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH

3. Looking at each [ɛ], notice the grey horizontal bands: these correspond to harmonics (see Figure 4.3). For each [ɛ] that you recorded, measure the frequency of the first 3 harmonics (H1-H3), plus of the 10th harmonic (H10). Use Table 4.2 to note down your measurements.

- Click on the centre (horizontally) of each harmonic, in the centre (vertically) of each [ɛ]
- A red horizontal bar should appear, with the frequency value on the left side of the window, in red.

**Q2:** Compare the frequency of H1 with the fundamental frequencies measured in 1 above. What does the first harmonic (H1) correspond to?

**TIP** If you have a very low voice, the first dark line you see may be H2, instead of H1. Ask your instructor if in doubt...

**Q3:** What is the relationship between the first and subsequent harmonics? (The relationship should be the same across [ɛ]s.)

**TIP** Keep in mind there will be measurement error here, so various relationships may not be as clear as they would be in an ideal world…

**SECTION III. FORMANTS**

Looking at the narrow-band spectrogram, you should notice that some harmonics are darker than others (see Figure 4.3). Darkness corresponds to loudness, i.e. the darkest harmonics are the ones that are the most amplified. These amplified harmonics form the FORMANTS that are characteristic of sonorant speech sounds.

4. Now, go back to the wide-band spectrogram:

- Go to: Spectrum > Spectrogram settings…
- Change the window length back to 0.005 ms (the default)

You will see that the formants appear on the wide-band spectrogram as thick dark bands.

5. Measure the first and second formants (F1 and F2) in the middle of each [ɛ] using the three techniques outlined below and note down your measurements in Table 4.3.

**Three ways to measure formants:**

a. By displaying the formants (red dots) and having Praat measure the frequency of each formant automatically (see Figure 4.4):
LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH

- Display the formant track: **Formant > Show formants**
- Place your cursor in the middle, stable portion of the vowel
- Go to **Formant > Formant listing**: a box will appear providing the time point at which the measurement was taken, and values for the first four formants at that time (F1 and F2 are the important ones now).

b. By displaying the formants and measuring the frequency of each one manually:

- Display the pitch track: **Formant > Show formants**
- Place your cursor in the center of each formant, in the middle of the vowel
- A red horizontal bar should appear, with the frequency value on the left side of the window, in red (see Figure 4.4).

c. By measuring the frequency without displaying Praat’s formants – this is sometimes easiest if Praat’s formant tracking goes wonky.

- Get rid of Praat’s formant tracking: **Formant > Show formants** (unclick)
- Place your cursor in the center of each formant, in the middle of the vowel
- A red horizontal bar should appear, with the frequency value on the left side of the window, in red.

**Q4:** Which method do you prefer and why?

**Q5:** Would you say that the formant frequencies are the same or different across [ɛ]s? (Be sure to take measurement error into account when answering this question.)
LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH

Figure 4.4 Measuring formants

SECTION IV. THE RELATIONSHIP BETWEEN HARMONICS AND FORMANTS

The relationship between the harmonics and the formants is captured in the SOURCE-FILTER MODEL of speech production. In this last section of the lab, think about what the source and filter might be in this model.

Section II. Harmonics, p. 28).
Get rid of the pitch contour: Pitch > Show pitch (unclick)

6. What is the ordinal number of the harmonic (H2, H5, H8, etc.) that is at the centre of the first formant, for each [ɛ]? Use Table 4.4 to note down your answer.

Q6: Does this harmonic have the same number across [ɛ]s? Why or why not?

Q7: What explanation is there for the pattern observed in Table 4.3 and Table 4.4: why would the harmonic number be different across [ɛ]s (Table 4.4), but the frequency of this harmonic (approximately = F1) be (approximately) the same across [ɛ]s (Table 4.3)?

⇒ To answer this question, think about what creates harmonics vs. formants…
LAB 4 – THE SOURCE-FILTER MODEL OF SPEECH

LAB 4 REPORT – THE SOURCE-FILTER MODEL OF SPEECH

SECTION I. FUNDAMENTAL FREQUENCY (F0) OR PITCH

Table 4.1 Fundamental frequency measurements

<table>
<thead>
<tr>
<th>Recording</th>
<th>Pitch contour (automatic)</th>
<th>Pitch contour (manual)</th>
<th>Waveform (one cycle)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ɛ] low pitch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ɛ] mid pitch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ɛ] high pitch</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q1: Which method do you prefer and why?

SECTION II. HARMONICS

Table 4.2 Harmonics measurements

<table>
<thead>
<tr>
<th>[ɛ] pitch</th>
<th>H1</th>
<th>H2</th>
<th>H3</th>
<th>H10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mid</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q2: Compare the frequency of H1 with the fundamental frequencies measured in 1 above. Based on this comparison, what does the first harmonic (H1) correspond to?

Q3: What is the relationship between the first and subsequent harmonics? (The relationship should be the same across [ɛ]s.)
SECTION III. FORMANTS

Table 4.3 Formants measurements

<table>
<thead>
<tr>
<th>Recording</th>
<th>With formant tracking (automatic)</th>
<th>With formant tracking (manual)</th>
<th>Without formant tracking (manual)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ɛ] low pitch</td>
<td>F1:</td>
<td>F1:</td>
<td>F1:</td>
</tr>
<tr>
<td></td>
<td>F2:</td>
<td>F2:</td>
<td>F2:</td>
</tr>
<tr>
<td>[ɛ] mid pitch</td>
<td>F1:</td>
<td>F1:</td>
<td>F1:</td>
</tr>
<tr>
<td></td>
<td>F2:</td>
<td>F2:</td>
<td>F2:</td>
</tr>
<tr>
<td>[ɛ] high pitch</td>
<td>F1:</td>
<td>F1:</td>
<td>F1:</td>
</tr>
<tr>
<td></td>
<td>F2:</td>
<td>F2:</td>
<td>F2:</td>
</tr>
</tbody>
</table>

Q4: Which method do you prefer and why?

Q5: Would you say the formant frequencies are the same or different across [æ]s? (Be sure to take measurement error into account when answering this question.)

SECTION IV. THE RELATIONSHIP BETWEEN HARMONICS AND FORMANTS

Table 4.4 Harmonics and formants

<table>
<thead>
<tr>
<th>Recording</th>
<th>Number of the harmonic corresponding to first dark band in narrow-band spectrogram (e.g. H1, H4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ɛ] low pitch</td>
<td></td>
</tr>
<tr>
<td>[ɛ] mid pitch</td>
<td></td>
</tr>
<tr>
<td>[ɛ] high pitch</td>
<td></td>
</tr>
</tbody>
</table>

Q6: Does this harmonic have the same number across [ɛ]s? Why or why not?

Q7: What explanation is there for the pattern observed in Table 4.3 and Table 4.4: why would the harmonic number be different across [ɛ]s (Table 4.4), but the frequency of this harmonic (approximately = F1) be (approximately) the same across [ɛ]s (Table 4.3)?

⇒ To answer this question, think about what creates harmonics vs. formants…

REFERENCES

Q8: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 5 – OBSTRUENT PLACE OF ARTICULATION

GOAL OF LAB 5
In this lab, we are going to explore the acoustic correlates of OBSTRUENT PLACE OF ARTICULATION. We shall see that the location of these correlates differ in stops vs. fricatives: while they are mainly “intrinsic” (within the consonant) for fricatives, they are mainly “extrinsic” (in the transitions to adjacent vowels) for stops. This phonetic fact can help to explain cross-linguistic phonological restrictions on adjacent consonants.

RECORDING
Generate the following sound files, containing the sound sequences listed.

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab5_a_stop_a.wav</td>
<td>apʰa, aba, atʰa, ada, akʰa, aga</td>
</tr>
<tr>
<td>Lab5_a_stop.wav</td>
<td>lap, lab, bat, bad, rack, rag</td>
</tr>
<tr>
<td>Lab5_i_stop_i.wav</td>
<td>ipʰi iби, itʰi, idi ikʰi, igi</td>
</tr>
<tr>
<td>Lab5_a_fricative_a.wav</td>
<td>afa, aθa, asa, aʃa, aha</td>
</tr>
</tbody>
</table>

SECTION I. STOP CONSONANTS

Several acoustic correlates distinguish different places of articulation in stops. The main ones are VOT, spectral pattern during aspiration (voiceless stops), and transition into the adjacent vowels. For this lab, we will focus on formant transitions in this section; we will discuss VOT and spectral pattern in class. Focus on the differences associated with place of articulation (i.e. the differences between /p b/, /t d/ and /k g/).

- Open the following sound files in Praat: Lab5_a_stop_a.wav and Lab5_i_stop_i.wav
- Focus on the voiced stops for now

1. In Table 5.1, note down the formant transition shape (particularly F2) between each voiced stop and the following [a] or [i] vowel (see Figure 5.1).

- Zoom in so that you can clearly see the formant transition from the stop into the following vowel.

2. Note down the movement contour of F2 (and F1 if you can see it) into the following vowel.
Q1: How do the different places of articulation differ with respect to the F2 transitions into the following vowels? What causes these differences?

Q2: Looking specifically at [ada] and [idi], do you notice a difference in the formant transitions? What do you think causes this difference?

SECTION II. FRICATIVES

Different places of articulation in fricatives are correlated with two main properties: spectral content and relative amplitude. By examining the overall spectral contour, peak frequency and the amplitude of peak frequency, we can have an idea of the properties of a fricative.

3. Use Table 5.2 to fill in the measurements you take on these three dimensions and compare between fricatives of different POA.
For this portion of the lab, make sure that the spectrogram is set to display frequencies up to 9000 Hz:

- Spectrum > Spectrogram settings…
- View range: up to 9,000Hz
- Open the following sound file in Praat: `Lab5_a_fricative_a.wav`
- Select approximately 40ms in the middle of each fricative
- Spectrum > View spectral slice
- For each fricative:
  - Take a screen shot of the spectral slice and paste it into your lab Word document. (If you can’t remember how to do this, refer to in Lab 1–Figure 1.10). Be sure to give the spectral slide an appropriate title.
  - Note down in Table 5.2 the spectral peak: the frequency or frequencies around which most of the energy is centered, i.e. the highest amplitude frequencies (the highest peaks)
  - Note down in Table 5.2 the amplitude of the peak frequency or frequencies (that you noted down above) Note: the positive dB values are louder than the negative dB values.

![Fricative spectral analysis](image)

Figure 5.2 Fricative spectral analysis
LAB 5 – OBSTRUENT PLACE OF ARTICULATION

**TIP** You can also get a good idea of the frequency ranges and their relative amplitudes by looking at the spectrogram.

**TIP** For English, “ballpark” measurements for [s] will be around 9,000Hz or higher, and for [ʃ] somewhere close to 5,000Hz.

**Q3:** Among the fricatives you measured, which ones are highest/lowest in amplitude? What do you think is the reason for this (think about articulation)?

**Q4:** Compare the spectral peaks of [s] vs. [ʃ]. What do you think causes the difference between these two fricatives?
**LAB 5 – OBSTRUENT PLACE OF ARTICULATION**

**LAB 5 REPORT – OBSTRUENT PLACE OF ARTICULATION**

**SECTION I. STOPS**

Table 5.1 Acoustic correlates of place of articulation in stops: formant transitions

<table>
<thead>
<tr>
<th>Correlate</th>
<th>Stops</th>
<th>b</th>
<th>d</th>
<th>g</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Formant transitions</td>
<td>[i] context</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>[a] context</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Q1:** How do the different places of articulation differ with respect to the F2 transitions into the following vowels? What causes these differences?

**Q2:** Looking specifically at [ada] and [idi], do you notice a difference in the formant transitions? What do you think causes this difference?

**SECTION II. FRICATIVES**

Table 5.2 Acoustic correlates of place of articulation in fricatives

<table>
<thead>
<tr>
<th></th>
<th>Peak frequency (Hz)</th>
<th>Amplitude of peak frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>[f]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[θ]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[s]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[ʃ]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[h]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Q3:** Among the fricatives you measured, which ones are highest/lowest in amplitude? What do you think is the reason for this (think about articulation)?

**Q4:** Compare the spectral peaks of [s] vs. [ʃ]. What do you think causes the difference between these two fricatives?

**REFERENCES**

**Q5:** Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 6 – GLIDES AND LIQUIDS

GOAL OF LAB 6
Sonorants are:
- similar to vowels in that they have formants
- different from vowels in that they are generally lower amplitude (and behave as consonants phonologically)

In this lab, we are going to explore the acoustic correlates of two types of sonorants: GLIDES [w,j] and LIQUIDS [ɹ,l].

RECORDING
Go to the CourseSpaces site and download the zip file Lab6_Soundfiles, containing the following files. Note, you can also generate these yourself; I have done it for you here to make sure that the sound files are clear enough for taking measurements.

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab6_Wi_Ju.wav</td>
<td>wi, ju</td>
</tr>
<tr>
<td>Lab6_Ri_iR.wav</td>
<td>ɹi, li, ɹi, il</td>
</tr>
</tbody>
</table>

SECTION I. GLIDES

1. Open the file Lab6_Wi_Ju.wav. Follow the instructions below and fill in Table 6.1 on the acoustic correlates of different glides

A. Formants

- In Table 6.1, note down the frequency of F1, F2 and F3 for each glide, as measured around the midpoint of the glide.

  **TIP** The midpoint of [w] should be at about 1.23s and the midpoint of [j] should be at about 3.25s.

Q1: Look at the formant structure of the glides: which vowel does each glide resemble?

B. Formant transitions

- In Table 6.1, either draw stylized lines to indicate the F1, F2 and F3 contours throughout each Glide-Vowel sequence, or briefly describe in prose the path of the contours that you observe.
Q2: Are any differences between the two Glide-Vowel contours, i.e. between the transitions out of the two glides? Articulatorily, what do you think causes these differences, and how are these articulatory differences reflected in the acoustics?

SECTION II. LIQUIDS

2. Open the file Lab6_Ri_iR.wav. Follow the instructions below and fill in Table 6.2 on the acoustic correlates of different liquids.

A. Formants

Use only the coda [ɹ] and [l] (the 3rd word [iɹ] and the 4th word [il] in Lab6_Ri_iR.wav) for these measurements: formants are easier to see in coda position because they are more “stretched out”.

- In Table 6.2, note down the frequency of F1, F2 and F3 for each liquid, as measured around the midpoint of the liquid

**TIP** The midpoint of [ɹ] should be at about 6.25s and the midpoint of [l] should be at about 8.3s.

Q3: Make note of the differences between each liquid. In particular, which formant is most different between the two?

B. Formant transitions

Again, use only the coda [ɹ] and [l] ([iɹ] and [il]) for these measurements.

- In Table 6.2, draw lines to indicate the F1, F2 and F3 contours throughout each VL sequence, or describe them in prose.

Q4: Do you notice any differences between the contours, i.e. between the transitions into the two liquids? What do you think causes these differences?

C. Formant transition durations: Onsets vs. Codas

Certain sounds are pronounced differently in onset vs. coda position, including liquids. In this last part of the lab, you will compare one acoustic correlate of liquids across syllabic positions: duration.
LAB 6 – GLIDES AND LIQUIDS

- **Onset**: Use [ɹi] [ɨl] for the measurement of onset liquids. Measure the duration from the beginning of the Liquid-Vowel transition (where the formants start to move) to the point at which the formants stabilize in the following vowel (see Figure 6.1). Note down your measurement in Table 6.2.

![Formant transition in onset position](image)

- **Coda**: Use [ɨl] [ɨl] for the measurement of coda liquids. Measure the duration between the beginning of the V-L transition (where the formants start to move) to the point at which the formants stabilize in the following liquid (see Figure 6.2). Note down your measurement in Table 6.2.
Q5: Compare the transition durations in onset vs. coda position ([ɪi] vs. [ɪi] and [ɪi] vs. [ɪi]): which are longer?

Q6: Think about articulatory differences between /l/ in onset vs. coda position. Given what you know about these differences (think of the allophones of /l/ in English), do you expect any acoustic differences? If so, do your observations match your expectations?
LAB 6 – GLIDES AND LIQUIDS

LAB 6 REPORT – GLIDES AND LIQUIDS

SECTION I. GLIDES

Table 6.1 Acoustic correlates of glides

<table>
<thead>
<tr>
<th></th>
<th>[w]</th>
<th>[j]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formants (Glides)</td>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
<td>F2</td>
<td></td>
</tr>
<tr>
<td>F3</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Formant transitions (Glide-Vowel)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(drawing or brief description)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q1: Look at the formant structure of the glides: which vowel does each glide resemble?

Q2: Are any differences between the two Glide-Vowel contours, i.e. between the transitions out of the two glides? Articulatorily, what do you think causes these differences, and how are these articulatory differences reflected in the acoustics?

SECTION II. LIQUIDS

Table 6.2 Acoustic correlates of liquids

<table>
<thead>
<tr>
<th></th>
<th>ɾ</th>
<th>ɾ</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formants (Liquids)</td>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
<td>F2</td>
<td></td>
</tr>
<tr>
<td>F3</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Formant transitions (Vowel-Liquid)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(drawing or brief description)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Formant transition duration</td>
<td>onset</td>
<td>onset</td>
</tr>
<tr>
<td>coda</td>
<td>coda</td>
<td></td>
</tr>
</tbody>
</table>

Q3: Make note of the differences between each liquid – which formant is most different between the two?
Q4: Do you notice any differences between the contours, i.e. between the transitions into the two liquids? What do you think causes these differences?

Q5: Compare the transition durations in onset vs. coda position (i̲ vs. i̲i and l̲i vs. i̲l) : which are longer?

Q6: Think about articulatory differences between /l/ in onset vs. coda position. Given what you know about these differences (think of the allophones of /l/ in English), do you expect any acoustic differences? If so, do your observations match your expectations?

REFERENCES

Q7: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 7 – NASALS

GOAL OF LAB 7
In this lab, we are going to explore the acoustic correlates of another class of sonorants, NASALS [m n ŋ]. Like other sonorants, nasals are:
- similar to vowels in that they have formants
- different from vowels in that they are generally lower amplitude (and behave as consonants phonologically), and have a more complex spectral composition

RECORDING
Generate the following sound file, containing the sound sequences listed.

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab7_Nasals.wav</td>
<td>ama, ana, aŋ</td>
</tr>
</tbody>
</table>

In this lab, you should focus on what is common between all three nasals.

1. Open the file **Lab7_a_N_a.wav**. Follow the instructions below and to fill in Table 7.1 on the acoustic correlates of different nasals.

A. Nasal F1 Values

If you can’t remember how to measure formants, refer back to LAB4 (p. 29).

- In Table 7.1, note down F1 for each nasal, as measured in the middle of the nasal.

**Q1:** Look at your measurements of F1 for the three nasals. Do these measurements vary across different places of articulation? Can you think of an explanation for this result?

B. Spectral slice

- Create spectral slices for each nasal and for one example of [a] (see LAB5, p. 35), from a 30ms selection for each sound. Take a screenshot of each spectral slice and paste these into your lab report Word document. Be sure to give the spectral slide an appropriate title.

**Q2:** Compare the spectral slices of the nasals vs. [a] – do you see any overall differences between the nasals on the one hand and [a] on the other? (Relate this to your answer to Q1 and Q3.)
C. Waveform

- Nasals have very distinctive waveforms. To see this, zoom in on 10 or so cycles of each nasal. Take a screenshot of the visible waveform and paste it into your lab report. Be sure to give the waveform an appropriate title.

**Q3:** How does the shape of the waveform of the nasals differ from that of [a]? What causes this pattern? (Relate this to Q1 and Q2 above.)

![waveform image]

**Figure 7.1 Nasal waveform**

D. Antiformants

Antiformants are the opposite of formants – they are bands of frequencies that are actively damped rather than amplified (we’ll talk about this in class). They show up on the spectrogram as bands of white, i.e. bands of ‘silence’ at particular frequencies (see Figure 7.2). They can be hard to see, so don’t worry if their measurement seems hard. For finding antiformants, you may find it easier to get rid of the formant tracking.

- Again in Table 7.1, note down the frequency of A1 (Antiformant 1), A2 and A3 for each nasal, as measured in the middle of the nasal.

**Q4:** Are there any systematic patterns across nasals: is there one antiformant with a similar frequency for all places of articulation?
Figure 7.2 Antiformants
Table 7.1 Acoustic correlates of nasals

<table>
<thead>
<tr>
<th>Correlates</th>
<th>[m]</th>
<th>[n]</th>
<th>[ŋ]</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. F1</td>
<td>A1</td>
<td>A1</td>
<td>A1</td>
</tr>
<tr>
<td>D. Antiformants</td>
<td>A2</td>
<td>A2</td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A3</td>
<td>A3</td>
<td>A3</td>
</tr>
</tbody>
</table>

Q1: Look at your measurements of F1 for the three nasals. Do these measurements vary across different places of articulation? Can you think of an explanation for this result?

Q2: Compare the spectral slices of the nasals vs. [a] – do you see any overall differences between the nasals on the one hand and [a] on the other? (Relate this to your answer to Q1 and Q3.)

Q3: How does the shape of the waveform of the nasals differ from that of [a]? What causes this pattern? (Relate this to Q1 and Q2 above.)

Q4: Are there any systematic patterns across nasals: is there one antiformant with a similar frequency for all places of articulation?

REFERENCES

Q5: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 8 – PHONATION TYPES

GOAL OF LAB 8
In this lab we are going to explore the acoustic correlates of the three main phonation types used across languages: MODAL VOICING, CREAKY VOICING, and BREATHY VOICING.

RECORDING
Go to the CourseSpaces site and download the zip file Lab8_SoundFiles, containing the files:

File name
Lab8_Breathy_voice.wav
Lab8_Modal_voice.wav
Lab8_Creaky_voice.wav

1. Open the sound files in Praat
2. Fill in the cells of Table 8.1 on the lab report to compare voicing types in terms of different parameters. Follow the instructions below for taking the appropriate measurements.

TIP Since the word “voice” occurs in all three recordings, this is a good word to use for comparing across phonation types. Unless otherwise noted, measurements should be taken using ~30ms selections around the transition point between [o] and [i] in [oi] of voice, i.e. where the formants start spreading out. Here are approximate transition points in each file:

- Modal voicing: 0.640s (see Figure 8.1)
- Creaky voicing: 0.703s
- Breathy voicing: 0.654s

TIP Keep in mind that what matters in comparing measurements are relative values rather than absolute values. E.g. in measuring jitter, what matters is which phonation type has the most jitter, not what the exact measurement is.

A. Fundamental frequency (F0)

- Fundamental frequency can be a good indication of phonation type. Note down F0 averaged over about 30ms around the measurement point of the three phonation types in Table 8.1 (if you can’t remember how to do this, see LAB3, p.18).

TIP When you select a range in the view window, the values of F0, amplitude etc. at the right of the view window will report averages calculated over the selected region – note that this does not work for formants (displayed at the left), however.
There are two things to consider here:

a. How regularly the pitch pulses occur = degree of periodicity in the waveform
b. How many higher-frequency components there are in the waveform = spectral noise

- The degree of periodicity can be quantified by measuring the **jitter**: the variation in the duration of successive $F_0$ cycles (see Figure 8.2). Follow the instructions below and note down your jitter measurements.

  **high jitter value = high degree of aperiodicity in the glottal source**

**TIP** You will not be able to get a jitter value unless the pitch pulses are showing up correctly in the waveform (the blue vertical lines on the waveform, see Figure 8.2). If at the suggested point of measurement (see above), there are no pitch pulses, measure jitter at some other point where you *do* see the pitch pulses.
Lab 8 – Phonation Types

Figure 8.2 Jitter measurement

- Measure Jitter value:
  - Pulses > Show pulses
  - Select a small portion (using a slightly larger value for this measurement, e.g. 70-80ms, can increase reliability) of the waveform around the measurement point OR where you see pitch pulses clearly
  - Pulses > Voice report
  - In the report window, get value for **Jitter (local)**, and note this down in Table 8.1

- Also on the waveform you can see how much spectral noise there is in the signal by how complex the waveform looks (see Figure 8.3).

  **lots of little jagged peaks = lots of spectral noise in the higher frequencies**

- Zoom in on the waveform until you can clearly see a few cycles (Figure 8.3). Note down in Table 8.1 your judgment on how much noise you observe.
C. Acoustic intensity

The three phonation types also differ in intensity. There are two ways to think about intensity differences, introduced below.

- Acoustic intensity can be ‘eyeballed’ by viewing the waveform or spectrogram directly. Note down the relative darkness on spectrogram and the relative size of deviations from zero waveform for different phonation types in Table 8.1.

  \[
  \text{relative darkness} = \text{loudness (spectrogram)}
  \]

  \[
  \text{relative size of deviations from zero waveform} = \text{loudness (waveform)}
  \]

- Amplitude can also be quantified by viewing the amplitude envelope (yellow contour) on the spectrogram display (see Figure 8.4). Note down in Table 8.1 the green amplitude value (in dB) on the right of the screen for different phonation types.
**LAB 8 – PHONATION TYPES**

- **Intensity > Show intensity**
- Find the **peak** intensity (*highest* point on yellow amplitude contour) during the vowel [oi]
- Click on the amplitude contour at this point
- Note the green amplitude value (in dB) on the right of the screen

![Image of waveform with annotations](image)

**Figure 8.4 Acoustic intensity**

**D. Spectral tilt**

Spectral tilt is the degree to which intensity drops off as frequency increases

- Spectral tilt can be eyeballed by looking at a spectral slice of the waveform, which gives the component frequencies and their amplitudes (see Figure 8.5). Note down the overall slope of the spectrum for different phonation types in Table 8.1 (steep, gradual, etc.).
  - Select a portion (30 ms) of the waveform around the measurement point (given above)
  - **Spectrum > View spectral slice**
  - The overall slope of the spectrum (= how quickly the amplitude drops off in the higher frequencies) is an indication of spectral tilt:

  **Steep slope = highly negative spectral tilt = rapid drop off in A of higher frequencies**

53
Figure 8.5 Measuring spectral tilt, zoomed-out view

- Spectral tilt can be quantified by comparing the amplitude of F0 to that of higher frequency harmonics, e.g. the second harmonic, the harmonic closest to the first formant, or the harmonic closest to the second formant. The easiest way to measure spectral tilt is by subtracting the amplitude of F0 (H1) from the amplitude of the second harmonic (H2) (see Figure 8.6). Fill in Table 8.1 with the spectral tilt value of the three phonation types.
  - Select the first few peaks (around 10 peaks) and zoom in so that you can see H1 and H2 clearly
  - In the spectral slice, click on the peak of H1 and get its amplitude
  - (The number on the left of the screen corresponds to the amplitude; the number at the top of the screen corresponds to the frequency)
  - Click on the peak of H2 and get its amplitude
  - Calculate spectral tilt by this formula: Spectral tilt = A(H2) - A(H1)

**TIP**
H1 is the first big-sized peak; H2 is the second one. There may often be one or two lower amplitude peaks before H1, so make sure you’re measuring the right peaks. If you click on the first big peak (H1), the value at the top of the vertical red bar gives you its frequency. Make sure this frequency corresponds to F0 (as verified by some other measurement technique – see LAB3, p.18). Also make sure that the frequency of H2 is approximately twice the frequency of H1 (see LAB4 for the reasoning here, p.29).
E. Formant frequency

- Non-modal phonation can affect the formant frequencies, particularly the first formant (F1). Note down F1 for each phonation type.
  - For this measurement, select about 30ms in the stable (middle) part of the [o] portion of the [oi] diphthong, not the transition point between [o] and [i].
  - On the spectrogram, click in the centre (vertical) of the first formant (F1)
  - The number at the left of the screen, at the end of the red horizontal bar gives you the frequency (in Hz)

*TIP* You can use the formant tracings if they help: Formant > Show formants
F. Duration of [oi]

- Duration can also be a good indication of phonation type (see Figure 8.7). Note down the duration of [oi] for each phonation type.
  - Measure the duration for the whole diphthong [oi] by selecting the vowel
  - You can read the duration from the panel above the selected segment

**TIP** To isolate [oi], you can use visual information (look for the change in the shape of the spectrogram/waveform). You can also use your ears.

![Figure 8.7 Duration measurement](image)

G. Overall clarity of the spectrogram

- Finally, phonation types differ in the overall clarity of the spectrogram – this has to do with the amount of noise in the signal, etc. Note down your impressions of overall clarity of the spectrogram of each phonation type.

**Q1:** Based on your observations, what seem to be the most and least reliable acoustic measurements/cues for distinguishing phonation types?
Table 8.1 Comparing acoustic correlates of different phonation types (enter values where measurements were taken; otherwise enter general comments)

<table>
<thead>
<tr>
<th></th>
<th>Modal voicing</th>
<th>Creaky voicing</th>
<th>Breathy voicing</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Fundamental frequency</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Periodicity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. jitter value</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. spectral noise</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intensity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. relative darkness on spectrogram / relative deviation on waveform</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. amplitude value (dB)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Spectral tilt</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. overall slope of the spectrum</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. A(H2) – A(H1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Formant frequency (F1 value)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Duration of [oi] (ms)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Overall clarity of spectrogram</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q1: Based on your observations, what measurements/cues seem to be the most and least reliable for distinguishing phonation types?

REFERENCES

Q2: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 9 – STRESS, PITCH ACCENT, TONE

GOAL OF LAB 9
In this lab we’re going to explore three different ways to use **pitch** within words: **STRESS** in English, **PITCH ACCENT** in Japanese, and **TONE** in Mandarin.

RECORDING
Generate the following sound file, containing three pairs of words with contrastive stress, each word spoken in the frame sentence “She said ________ three times”. Recording these words in a frame sentence will make it easier to produce them with a natural stress pattern.

Note: you can also download these from the CourseSpaces file, if you are having trouble with clarity.

Lab9_English_Stress.wav  
rebel (noun vs. verb: [ˈrebəl] vs. [jəˈbel])  
convict (noun vs. verb: [ˈkɔnvɪkt] vs. [kənˈvɪkt])  
trust (adjective: [ˈtrʌstɪ]) vs. trustee (noun: [ˈtraʊstɪ])

Also, go to [http://web.uvic.ca/ling/coursework/ling380/index.html](http://web.uvic.ca/ling/coursework/ling380/index.html) and download the zip file containing the files:

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds included</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab9_Japanese_PitchAccent.wav</td>
<td>hási, hasí, hasi o nuru, hasí o nuru, hasi o nuru</td>
</tr>
<tr>
<td>Lab9_Mandarin_Tone.wav</td>
<td>ma55, ma35, ma214, ma51</td>
</tr>
</tbody>
</table>

SECTION I. ENGLISH STRESS

The most familiar way to use pitch, at least for English speakers, is to signal what we call **STRESS** (c.f. *refuse* used as a noun vs. as a verb). In English, stress is **contrastive**: it can create differences in meaning, e.g. **trust** vs. **trustee**. In this first part of the lab, your task is to explore the acoustic correlates of stress in English (pitch, amplitude, duration) and to see whether they are the same or different across stress positions (first syllable vs. second syllable stress).

1. Open the file **Lab9_English_Stress.wav** and extract from the frame sentences the following words (see LAB 1 –, p. 5 if you can’t remember how to extract sections of sound files):

   rebel – noun vs. verb  
   convict – noun vs. verb  
   trusty (adjective) vs. trustee (noun)

2. Use Table 9.1 to note down the measurements of the duration, pitch, and intensity of the relevant segments in each word.
Lab 9 – Stress, Pitch Accent, Tone

- Display the pitch and intensity contours
- For duration: measure the duration of each vowel (two per word, one stressed and one unstressed)
- For pitch and intensity: measure the mean pitch and amplitude of each vowel – it is more common in work on prosody to average across the entire vowel, rather than selecting a small portion of it, as we’ve done in previous labs for other measurements
  - Highlight the vowel portion of the waveform/spectrogram
  - Mean pitch (blue) and intensity (green) values of the highlighted region will be displayed in the right portion of the View & Edit window (see Figure 9.1)

![Highlight selected vowel](image)

**Figure 9.1 Measuring mean pitch and intensity in Praat**

Q1: Based on your observations, what is/are the most important acoustic correlate(s) of stress in English? What differences, if any, do you notice between how stress is realized in first-syllable stress (e.g. trusty) and second-syllable stress (e.g. trustee) words? Are there other cues to stress that you think might be relevant, but that you didn’t measure? What are these, and how would you measure them?
SECTION II. JAPANESE PITCH ACCENT

Pitch accent is another way to mark prominence. Unlike stress, pitch accent uses primarily pitch (as opposed to a combination of cues) to signal the prominent syllable. Japanese is an example of a pitch accent language (Note: languages can have either stress or pitch accent, but not both; they can also have neither).

3. Open the file Japanese_PitchAccent.wav, which contains the words below (in these examples, the acute accent, e.g., hási, indicates accent) – note that each word and phrase is repeated several times in the file:

<table>
<thead>
<tr>
<th>hási</th>
<th>‘chopsticks’</th>
<th>hási o nuru</th>
<th>‘paint a bridge’</th>
</tr>
</thead>
<tbody>
<tr>
<td>hasí</td>
<td>‘bridge’</td>
<td>hasí o nuru</td>
<td>‘paint chopsticks’</td>
</tr>
<tr>
<td>hasi</td>
<td>‘end’</td>
<td>hasi o nuru</td>
<td>‘paint the end’</td>
</tr>
</tbody>
</table>

4. Use Table 9.2 to note down the shape of the pitch contours (flat, rising, falling, rising-falling, etc.) and important pitch values associated with each word/phrase (the first word is done for you as an example).

   o For the words in isolation (first 3): measure the average pitch of each vowel
   o For the words in a phrase (last 3): measure the average pitch of the first vowel, the second vowel, and of the phrase o nuru

Q2: Based on your observations, how does pitch accent work in Japanese, i.e. how does the accented syllable affect the pitch of the whole word/phrase?

SECTION III. MANDARIN TONE

Mandarin illustrates the most complex way of using pitch. Whereas stress and pitch accent both basically involve a binary distinction in pitch (stressed vs. unstressed; accented vs. unaccented), tone involves more than a binary distinction. In the case of Mandarin, four different pitches, or tones, are used to signal phonemic contrast.

5. Open the file Mandarin_Tone.wav, which contains the four words that all have [ma] as their segmental content, but that each have a different tone:

<table>
<thead>
<tr>
<th>55</th>
<th>high level</th>
<th>ma55</th>
<th>‘mother’</th>
</tr>
</thead>
<tbody>
<tr>
<td>35</td>
<td>high rising</td>
<td>ma35</td>
<td>‘hemp’</td>
</tr>
<tr>
<td>214</td>
<td>low falling</td>
<td>ma214</td>
<td>‘horse’</td>
</tr>
<tr>
<td>51</td>
<td>high falling</td>
<td>ma51</td>
<td>‘scold’</td>
</tr>
</tbody>
</table>

6. Use Table 9.3 to note down the frequencies used in each of the four tonal patterns. Measure the frequency at the start and end of the vowel, and at any turning points in the pitch contour.
**LAB 9 – STRESS, PITCH ACCENT, TONE**

*TIP*  For the most part you can use Praat’s pitch tracking function. There are some places where the tracking function cuts out though (see Figure 9.2). To measure in such places, use the waveform. (If you can’t remember how to do this, refer to LAB3, p.18)

![Pitch tracking function cuts out here. Use the waveform to measure pitch or try lowering the minimum pitch (Pitch settings) to get a continuous contour](image)

Figure 9.2 Tone measurement in Mandarin

**Q3:** From what you can tell, is there a consistent frequency associated with each phonological pitch number? For example, in the high level, high rising, and high falling tones, each of which includes a “5” to designate “high,” does “5” consistently represent the same pitch? What does this tell you about the relationship between phonological tone and phonetic pitch?

- Now record yourself trying to reproduce each of the Mandarin tones. Take the same measurements on your own speech as you took for the Mandarin speech, and enter the values in Table 9.4

**Q4:** How does your speech differ from the original Mandarin speech, in terms of:

- Overall pitch range used (absolute pitch): your minimum and maximum pitch vs. the minimum and maximum speech of the Mandarin recording.
- Relative pitch used, particularly in the contour tones: 35, 214, 51: what range of pitches do you use (min vs. max), compared to the original recording?

**Q5:** Do you tend to overdo (exaggerate) the tones, or underdo them?
SECTION I. ENGLISH STRESS

Table 9.1 Acoustic correlates of stress in English

<table>
<thead>
<tr>
<th>Word</th>
<th>Stressed syllable (e.g. first, second)</th>
<th>Duration (ms)</th>
<th>Pitch (Hz)</th>
<th>Intensity (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(noun)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebel</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(verb)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convict</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(noun)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Convict</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(verb)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trustee</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trusty</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q1: Based on your observations, what is/are the most important acoustic correlate(s) of stress in English? What differences, if any, do you notice between how stress is realized in first-syllable stress (e.g. trusty) and second-syllable stress (e.g. trustee) words? Are there other cues to stress that you think might be relevant, but that you didn’t measure? What are these, and how would you measure them?
**SECTION II. JAPANESE PITCH ACCENT**

Table 9.2 Description of pitch accent in Japanese

<table>
<thead>
<tr>
<th></th>
<th>Pitch contour and key frequencies (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>hási</td>
<td>Falling: [a] = 145 $\rightarrow$ [i] = 85</td>
</tr>
<tr>
<td>hasí</td>
<td></td>
</tr>
<tr>
<td>hasí o nuru</td>
<td></td>
</tr>
<tr>
<td>hasí o nuru</td>
<td></td>
</tr>
<tr>
<td>hasí o nuru</td>
<td></td>
</tr>
</tbody>
</table>

Q2: Based on your observations, how does pitch accent work in Japanese, i.e. how does the accented syllable affect the pitch of the whole word/phrase?
SECTION III. MANDARIN TONE

Table 9.3 Description of the pitch contours used in Mandarin

<table>
<thead>
<tr>
<th>Word</th>
<th>F (start of vowel)</th>
<th>F (turning point)</th>
<th>F (end of vowel)</th>
<th>Pitch contour (flat, falling, rising, falling-rising, etc.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ma55</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ma35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ma214</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ma51</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q3: From what you can tell, is there a consistent frequency associated with each phonological pitch number? For example, in the high level, high rising, and high falling tones, each of which includes a “5” to designate “high,” does “5” consistently represent the same pitch? What does this tell you about the relationship between phonological tone and phonetic pitch?

Table 9.4 Description of the pitch contours used in imitating Mandarin (OPTIONAL)

<table>
<thead>
<tr>
<th>Word</th>
<th>F (start of vowel)</th>
<th>F (turning point)</th>
<th>F (end of vowel)</th>
<th>Pitch contour (flat, falling, rising, falling-rising, etc.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ma55</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ma35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ma214</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ma51</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q4: How does your speech differ from the original Mandarin speech, in terms of:
   o Overall pitch range used (absolute pitch): your minimum and maximum pitch vs. the minimum and maximum speech of the Mandarin recording.
   o Relative pitch used, particularly in the contour tones: 35, 214, 51: what range of pitches do you use (min vs. max), compared to the original recording?

Q5: Do you tend to overdo (exaggerate) the tones, or underdo them?

REFERENCES

Q6: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 10 – PROSODY, RHYTHM

LAB 10 – PROSODY AND RHYTHM

GOAL OF LAB 10
Aside from segmental differences, many languages and dialects within a language differ in their prosodic features. In this lab, we will explore two kinds of prosodic features: intonation and rhythm. In terms of intonation, we will compare yes/no question intonation in English vs. Skwxwu7mesh. In terms of rhythm, we will compare different dialects of English. For measuring rhythm, we will use also learn about Praat scripting.

RECORDING
Generate a soundfile (Lab10_EnglishIntonation.wav) which includes the following two sentences:
- Statement: You’re going paddling.
- Question: You’re going paddling?

Also generate a recording (Lab10_EnglishRhythm.wav) of yourself reading the “North Wind and the Sun” passage below. Note: you may have to make several attempts before you are able to read it through without mistakes or hesitations.

The North Wind and the Sun were disputing which was the stronger, when a traveler came along wrapped in a warm cloak. They agreed that the one who first succeeded in making the traveler take his cloak off should be considered stronger than the other. Then the North Wind blew as hard as he could, but the more he blew the more closely did the traveler fold his cloak around him; and at last the North Wind gave up the attempt. Then the Sun shined out warmly, and immediately the traveler took off his cloak. And so the North Wind was obliged to confess that the Sun was the stronger of the two.

Also, go to http://web.uvic.ca/ling/coursework/ling380/index.html and download the zip file containing the files:

File name
Lab10_Skwxwu7mesh_Intonation.wav
Lab10_Singapore.wav
Lab10_RhythmScript.praat

SECTION I. PROSODY: QUESTION INTONATION IN ENGLISH VS. SKWXWU7MESH
You probably have a fairly good intuition about how questions differ from statements in English. But what do you think: are these differences universal? In this lab, you portion of the lab, you
will take a look at the pitch differences between statements and questions in English, and see if these differences also exist in a completely unrelated language: Skwxwu7mesh (Squamish; a Central Salish language of British Columbia).

1. Use Praat to examine how intonation differs between statements and questions in English
   
   o Open the sound file Lab10_EnglishQs.wav
   o Compare the pitch contour of the statement with that of the question. Remember that you might need to adjust the pitch minimum and maximum to optimize the contour (Go to: Pitch > Pitch settings… and change the Pitch Range values in the top two boxes, especially the first box, which is the lowest pitch that will be displayed)
   o Note down the pitch at key points in each pitch contour: beginning, end, turning points (if applicable)
   o Note down in Table 10.1 where in the sentence the turning points occur, if applicable (i.e. on which word or syllable)

   Q1: Based on your observations, how would you describe the pitch contour of statements vs. questions in English?

2. Use Praat to examine how intonation differs between statements and questions in Skwxwu7mesh
   
   o Open the sound file Lab10_Skwxwu7meshQs.wav and follow the same steps as in 2 above, using Table 10.2 to note down your observations.

   Q2: How would you describe the pitch contour of statements and of questions in Skwxwu7mesh?

   Q3: Based on your very small sample, would you say that the intonation of statements vs. questions is universal?

SECTION II. RHYTHM ACROSS DIALECTS OF ENGLISH

In this section of the lab, we will compare rhythm in Singapore English vs. Western Canadian English (or whichever dialect you speak), by comparing %V and delta-C measurements, some of the first metrics used to quantify rhythm across languages (e.g. Ramus et al. 1999 – see below). To do this, we will use the first sentence of the passage “The North Wind and the Sun”, which you recorded.

3. Use Praat’s Textgrid function to segment this sentence into C and V intervals, and then run a Praat script to extract durational information of these intervals, computer %V and delta-C measurements, and import the output into an Excel spreadsheet for data analysis and presentation.
   
   o Open the sound files Lab10_CanadianBC.wav and Lab10_Singapore.wav in Praat
Create a textgrid with C and V intervals; this will be used in our Praat script, below:

- Extract the first sentence from each reading passage (see Lab 1 –, p. 5 if you can’t remember how to do this)
- Create a textgrid for your extracted sentence with three interval tiers: sentence, segment, and CV (see Lab 1 –, p. 6 if you can’t remember how to do this)
- Open the sound file and textgrid together, and use the textgrid to segment the sentence into C and V sequences (see Figure 10.1 – only the CV tier is illustrated). NOTE: adjacent Vs are segmented into a single V interval; adjacent Cs are segmented into a single C interval.

![Image of textgrid and sound wave](image)

**Figure 10.1 Segmenting a sound file into CV sequences**

Use the Praat script provided to automatically extract the duration of each C and V interval and import this information into a spreadsheet, along with automatically measured %V and delta-C values.

- In the Praat objects panel, click on Praat > Open Praat Script… and select the script: Lab10_RhythmScript.praat (you can also double-click on the script, and it should automatically open in Praat)
- Select the soundfile and textgrid of the first sentence together using the Shift or the Control key
- In the script box, click on Run
Open the resulting Excel spreadsheet, and note down the %V (listed as ‘Percentage’ under the ‘V Dur’ column) and delta-C (listed as ‘StdDev’ under the ‘C Dur’ column) values for each dialect of English.

Plot the %V and delta-C data points you obtained for the two dialects of English along with Ramus et al’s data, in a single figure.

- In a new Excel spreadsheet, make three column headings: Language, %V, delta-C
- In the Language column, list the two English dialects you examined, and the languages listed in Table 1 of Ramus et al. (1999, p. 272)
- In the %V column, list your results for each English dialect from the Praat script output, and the corresponding values in Table 1 of Ramus et al. (1999, p. 272)
- In the delta-C column, also list your results for each English dialect from the Praat script output, and the corresponding values in Table 1 of Ramus et al. (1999, p. 272) – note that Ramus et al. multiply their delta-C values by x100, so you should do the same with your numbers
- Highlight the numbers in the %V and delta-C columns, and click on Insert > Scatter plot
- You’ll probably want to change the scales of the axes so that the data points fill up most of the chart. You can do this in the Axis Options, by clicking on the numbers on each axis.
- Click on Quick Layout (top left) and select the graph type that has axis titles and labels for individual data points; the default label of each data point is the x and y coordinates (e.g. 40.1, 5.35)
- Click on the text box that goes with each data point and change its label to the appropriate language/dialect name. You can also move the text boxes around if you need to for clarity.
- Click on the text box that goes with each axis and label it appropriately. Also label the figure.
- Click on Select Data (the top right); click on Series 1; click on Edit and change the name to Language/dialect.
Figure 10.2 Plotting rhythm as a function of %V and delta-C

Note: much of the clicking is somewhat finicky – be warned! Your final graph should look something like Figure 10.2 (but with the addition of your data points).

Q4: Where do the two dialects of English languages fall with respect the Ramus et al. (1999) classification? How do they compare to the values they obtained for English?

Q5: How might you explain the differences in values between the dialects that you studied, and between them and the dialect of English considered in Ramus et al. (1999)? Think about what phonetic and phonological differences might affect %V and delta-C measurements; also, refer to Ramus et al. (1999) for further details on their study (the paper is available on the CourseSpaces site).

Optional extra section on dialects of English

Having just spent some time listening to the Singapore vs. Canadian English (as you segmented the speech), you probably now have a sense of what other properties differ between these dialects: sounds, words, intonation contours, etc.

4. For each dialect, note down your impression of what makes this dialect unique: what distinguishes it from the other dialects.

5. Focusing on the words, sounds, intonation contours, etc. that you came up with as being unique for each dialect (see a. above), take the appropriate acoustic measurements, and compare them to similar measurements in other dialects. Note down your observations (see example tables on the worksheet).
**TIP** To compare dialects, it is often useful to focus on specific words or phrases (e.g. ‘disputing’ or ‘last’; ‘should be considered stronger than the other’ – see example tables in the lab report).

**TIP** A few examples of the segmental differences that you can focus on are included in the lab report. You are encouraged to look at other aspects that interest you, including suprasegmental aspects.
LAB 10 – PROSODY, RHYTHM

LAB 10 REPORT – PROSODY, RHYTHM

SECTION I. PROSODY: QUESTION INTONATION IN ENGLISH VS. SKWXWU7MESH

Table 10.1 Description of the pitch contours in English statement vs. question intonation

<table>
<thead>
<tr>
<th>Sentence</th>
<th>Turning point(s)</th>
<th>Frequency (Hz)</th>
<th>Description of intonation contour</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement</td>
<td>Key pitch point(s) word/syllable:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Key pitch point(s) word/syllable:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q1: How would you describe the pitch contour of statements and of questions in English?

Q2: How would you describe the pitch contour of statements and of questions in Skwxwu7mesh?

Table 10.2 Description of the pitch contours in Skwxwu7mesh statement vs. question intonation

<table>
<thead>
<tr>
<th>Sentence</th>
<th>Turning point(s)</th>
<th>Frequency (Hz)</th>
<th>Description of intonation contour</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statement</td>
<td>Key pitch point(s) word/syllable:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Question</td>
<td>Key pitch point(s) word/syllable:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Q3: Based on your very small sample, would you say that the intonation of statements vs. questions are universal?

SECTION II. RHYTHM ACROSS DIALECTS OF ENGLISH

Q4: Where do the two dialects of English languages fall with respect the Ramus et al. (1999) classification? How do they compare to the values they obtained for English?
LAB 10 – PROSODY, RHYTHM

Q5: How might you explain the differences in values between the dialects that you studied, and between them and the dialect of English considered in Ramus et al. (1999)? Refer to Ramus et al. (1999) for further details on their study (the paper is available on the CourseSpaces site).

OPTIONAL EXTRA SECTION ON DIALECTS OF ENGLISH

Table 10.3. Pronunciation of /t/ in ‘disputing’

<table>
<thead>
<tr>
<th></th>
<th>Glottalisation?</th>
<th>Aspiration?</th>
<th>IPA symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian (BC)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 10.4. Final nasal in ‘disputing’

<table>
<thead>
<tr>
<th></th>
<th>F2 movement*</th>
<th>IPA symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian (BC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Movement upwards = into velar pinch

Table 10.5. Vowel quality in ‘cloak’ (you can make similar tables for other vowels)

<table>
<thead>
<tr>
<th></th>
<th>F1 (Hz)*</th>
<th>F2 (Hz)*</th>
<th>duration (ms)</th>
<th>IPA symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian (BC)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*You can take a single measurement, or measure multiple points if this seems more appropriate.

Table 10.6. Glottalisation of consonants in ‘wrapped in a warm cloak’

<table>
<thead>
<tr>
<th></th>
<th>Transcription of ‘and at l…’ in ‘and at last’)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian (BC)</td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td></td>
</tr>
</tbody>
</table>

REFERENCES

Q6: Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.
LAB 11 – SPEECH SYNTHESIS

GOAL OF LAB 11
The goal of this lab is to try your hand at some speech synthesis. The possibilities for manipulating speech are virtually unlimited. In this lab we will play with VOICING and TONE. You will also get to create your own RAP SONG!

RECORDING
Generate the following sound file, containing the sound sequences listed.

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab11_pa_ba.wav</td>
<td>pa, ba</td>
</tr>
<tr>
<td>Lab11_lap_lab.wav</td>
<td>lap, lab</td>
</tr>
</tbody>
</table>

Also, go to [http://web.uvic.ca/ling/coursework/ling380/index.html](http://web.uvic.ca/ling/coursework/ling380/index.html) and download the zip file containing the files:

<table>
<thead>
<tr>
<th>File name</th>
<th>Sounds to record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lab11_T1_T4.wav</td>
<td>(ma in T1, ma in T4)</td>
</tr>
</tbody>
</table>

SECTION I. VOICING MANIPULATION

In the first section of the lab, we will learn to change a voiceless stop [p] into a voiced one [b].

A. VOT manipulation

As we discovered in LAB5, VOT is an important acoustic cue for voicing in stops. Changing the VOT of a stop may change the identity of a stop. In this section you will manipulate the VOT of the stop in [pa] to get the stop in [ba].

1. Measure the VOT of [pa] vs. [ba] in natural speech and note down your measurements in Table 11.1 (if you can’t remember how to do this, refer to LAB2, p.15).

2. Follow the instructions below to create a [pa]~[ba] continuum by gradually cutting out aspiration in [pa]. Also note down the VOT of each token along your [pa]~[ba] continuum in Table 11.1.

   o Open sound file **Lab11_pa_ba.wav** in the Edit window.
   o Zoom in on [pa]: leaving the burst as is, cut out the aspiration in **10-20 ms steps**, until there’s no more aspiration at all (Figure 11.1):
     * Go to Edit > Cut
   o Each time you cut out 10-20ms of aspiration, extract the token as a new sound file:
     * Highlight [pa]
     * File > Extract selected sound (preserve times)
In order to keep track of the tokens you are creating, rename the extracted selection:
- In the Praat objects panel: **Rename**
- **Sound untitled** > Pa1 (after first cut), Pa2 (after second cut), P3...

You'll end up with about four tokens along a [pa]~[ba] continuum.

**Figure 11.1 VOT manipulation**

**Q1:** Compare the synthesized [Pa]s\(^5\) you created with the natural [ba]:
  a. Which token sounds the closest to the original [ba], and how close does it sound?
  b. What other manipulations do you think would help to make it more natural? (and how would you do these manipulations?)

---

\(^5\) “P” is used as the abstract version of [p ~b] that isn’t specified for voicing. This is common practice in phonological analysis as well.
LAB 11 – SPEECH SYNTHESIS

B. Vowel length manipulation (optional)

Another important acoustic cue to voicing in stops in coda position is the length of the preceding vowel. In this part, you will manipulate the length of the vowel in [lap] to make [lap] sound like [lab]. This part of the lab is optional.

3. Open sound file Lab11_lap_lab.wav in the View & Edit window. Measure the length of the vowel in [lap] vs. [lab] in natural speech and note down your measurements in Table 11.2. There are two ways to manipulate vowel length: an easy/not so good way and a more difficult/better way. You can choose either way or try both.

Use the easy/not so good way to lengthen a vowel:

- In the View & Edit window, select a steady portion of the vowel in [lap] (20ms or so)
- Copy and paste it after itself as many times as is necessary to reach the duration of the [a] in the natural [lab]
  - Edit > Copy selection to Sound clipboard (or Control/Cmd-C)
  - Edit > Paste after selection (or Control/Cmd-V)
- When you’re done copying and pasting, extract the token as a new sound file:
  - Highlight [lap]
  - File > Extract sound selection (preserve times)
  - In the Praat objects panel: Rename
  - Sound untitled > laP1
- Measure the duration of the new vowel duration in [laP1] and note down the values in Table 11.2.

Q2: Compare the synthesized [laP1] you created with the natural [lab].
  a. How close do they sound?
  b. What further manipulation(s) would make the synthesized and natural tokens more similar?
  c. What problems do you find with this way of manipulation?

Now try the more difficult/better way to lengthen a vowel:

- Re-open sound file Lab11_lap_lab.wav (from the desktop)

TIP You have to re-open the file because the Lab11_lap_lab.wav you opened before has now been modified.

- Create a manipulation object for the sound file:
  - Highlight the newly opened sound file Lab11_lap_lab.wav in the Praat objects panel.
• Click **Manipulate** on the right side of the objects panel and then **To manipulation** (keep default settings).
• This will create a new object in the Praat objects list “Manipulation LAB11_lap_lab”.
• In the Praat objects list, highlight “**Manipulation LAB11_lap_lab**” and click on **View & Edit** in the Praat objects panel

→ This will open an edit window with three blocks (see Figure 11.2):
• The waveform block
• The pitch manipulation block with the pitch contour as a series of green balls
• The duration manipulation block.

Ignore the pitch manipulation block for this section of the lab and focus on the duration block.

**To insert duration manipulation points in the duration block:**
• Locate the vowel portion in [lap]
• Insert a duration point at the beginning and end of the vowel (see Figure 11.2):
  • Place cursor at beginning/end of the vowel
  • **Go to Dur > Add duration point at cursor**

**Now insert two additional duration points:** one immediately before the beginning of the vowel and one immediately following the vowel (during the closure duration of [p] is fine). These two points are created to ensure that the remainder of your sound file retains its original duration, which will be introduced in detail below.

→ You should now have four duration points:
• pre-vowel (immediately before the beginning of the vowel)
• vowel-initial (beginning of the vowel)
• vowel-final (end of the vowel)
• post-vowel (immediately following the vowel, i.e. following the vowel-final point)

Dragging the vowel-initial and vowel-final points up will increase the duration of the interval; dragging the points down will have the opposite effect. For example, dragging the vowel-initial and vowel-final points to a duration level of 2 will double the length of the original selection between the two points (if the vowel was 50ms, the process will change it to 100ms) (See Figure 11.2).
LAB 11 – SPEECH SYNTHESIS

- To lengthen the vowel:
  - Leave the pre-vowel and post-vowel duration points at the level of 1.000 (they should already be there by default. If they are not, drag them to the level of 1.000). You can find the duration level value in red at both ends of the red horizontal line. (See Figure 11.2)
  - Drag the vowel-initial and vowel-end points up as much as you feel is necessary to reach the duration of [a] in the natural [lab].

- In the manipulation window: **File > Publish resynthesis.**
  → This will put a new sound in the Praat objects panel: SoundfromMapulationEditor
- Select the file in the object window and **Rename: labP2**
- Open this file in the Edit window, and measure the duration of the vowel in labP2. Note down your measurement in Table 11.2.

![Figure 11.2 Duration manipulation](image-url)

In this example, the vowel-initial point and the vowel-final points were both dragged to the level of around 2.000, this will almost double the duration of the original selection.

Drag these two points up to increase the duration of the interval between the two points

Leave the pre-vowel and post-vowel points at the level of 1.000
Q3: Compare [laP2] with [laP1] and the original [lab].
   a. Which of your synthesized tokens sounds closer to the natural [lab]?
   b. How natural are these tokens compared to the natural [lab]? Which file ([laP1] vs. [laP2]) sounds more natural?
   c. What other manipulations do you think might make it sound better?

SECTION II. TONE MANIPULATION

As we discovered in LAB9, pitch contour is used in Mandarin to signal phonemic contrast. In this component of the lab, you will transform one Mandarin tone into another one by manipulating its pitch contour.

4. Follow the instructions below and note down the pitch and duration of the natural T1 and T4 in Table 11.3.

   o Open the sound file LAB11_T1T4.wav in Praat
   o In the View & Edit window, on the pitch contour, measure the frequency at the start and end of the T1 and T4 syllables. Note down your measurements in Table 11.3. If there are some places where the tracking function cuts out, use the waveform to measure and calculate the pitch (if you can’t remember how to do this, refer to LAB3, p.19).
   o Measure the duration of the syllables in the natural T1 and T4, respectively, and calculate the ratio between T1 and T4 (T1/T4). Note down your measurements in Table 11.3.

A. Pitch manipulation

5. Follow the instructions below to transform Tone 1 into Tone 4 by manipulating the pitch of the sound file.

   o To create a manipulation object of the sound file:
     • Back in the Praat objects panel, highlight LAB11_T1T4
     • Click Manipulation > To Manipulation… (keep default settings)
     • This will create a new object in the Praat objects panel “Manipulation LAB11_T1T4”
     • Highlight this object and click on View & Edit in the Praat objects panel: this will bring up the manipulation window – the same as you saw in 0 above
     • Focus on the pitch manipulation block

   o Drag the pitch balls to create a new pitch contour:
     • A series of pitch manipulation points have been generated by Praat automatically
     • Zoom in to T1
     • Drag the first pitch ball of T1 up/down until its frequency is the same as the start point frequency of the natural T4 (measured in 4 above; see Table 11.3)
     • Drag the last pitch ball of T1 down until its frequency is the same as the end point frequency of natural T4 (also measured in 4 above)
LAB 11 – SPEECH SYNTHESIS

- Drag all the balls in between until you get a contour between start and end points that is similar to the natural T4 contour
  - In the manipulation window: File > Publish resynthesis. This will put a new sound in the Praat objects panel: SoundfromManipulationEditor
  - Rename this: SyntheticT4_1
    - Do NOT close the manipulation window at this point, we will come back to this file later
  - Open the file SyntheticT4_1 in the View & Edit window. Measure the beginning and end-point frequencies and the duration of syntheticT4_1. Note down your measurements in Table 11.3.

Q4. Compare SyntheticT4_1 with the natural T4.
  a. How close is it to the natural T4?
  b. What else do you think you could do to make it sound more like T4?

Figure 11.3 Pitch manipulation
B. Duration manipulation

6. In this section, on the basis of your pitch manipulation, you will change the duration of the original T1 to make it more similar to T4.
   o Go back to the tone manipulation window, and identify the original T1 portion.
   o Find the duration manipulation block (the bottom block).
   o Insert four duration points (refer back to Section I, p.73):
     • pre-syllable (immediately before the syllable)
     • syllable-initial (at the beginning of the syllable)
     • syllable-final (at the end of the syllable)
     • post-syllable (during the pause following the syllable)
   o Manipulate the duration of T1 so that it resembles the natural T4.

   TIP Make sure that the pre-syllable and post-syllable duration points are set at the duration level of 1.000. They should be there by default.

   TIP To lengthen the duration of T1 (see above), drag the syllable-initial and syllable-final points up; to shorten it, drag the two points down.

   o Listen to the token to see if you are satisfied with the result. Change the duration if you are not.
   o Now, to combine the result of pitch and duration manipulations, you can re-save the resynthesized file you have created.
      • In the manipulation window: File > Publish resynthesis. This will put a new sound in the Praat objects panel: SoundfromMapulationEditor
      • Rename this: SyntheticT4_2

7. Open SyntheticT4_2 in the Edit window: measure the beginning and end-point frequencies and the duration of SyntheticT4_2. Note down your measurements in Table 11.3.

Q5: Listen to SyntheticT4_1 and SyntheticT4_2 and compare them to the natural T4:
   a. Which synthesized T4 is more similar to the natural T4?
   b. What can you conclude from the difference between the two synthesized T4s about the acoustic cues to tone in Mandarin?

SECTION III. RAP SONG

8. As an easy, fun component to this lab, you can record yourself saying a sentence and then create a rap song with it by copying and pasting bits here and there.
LAB 11 – SPEECH SYNTHESIS

LAB 11 REPORT – SPEECH SYNTHESIS

SECTION I. VOICING MANIPULATION

Table 11.1 VOT manipulation

<table>
<thead>
<tr>
<th>VOT (ms)</th>
<th>[pa] (natural)</th>
<th>[Pa1]</th>
<th>[Pa2]</th>
<th>[Pa3]</th>
<th>([Pa4])</th>
<th>([Pa5])</th>
<th>[ba] (natural)</th>
</tr>
</thead>
</table>

Q1. Compare the synthesized [Pa]s you created with the natural [ba]:
   a. Which token sounds the closest to the original [ba], and how close does it sound?
   b. What other manipulations do you think will be needed to make it more natural? (and how
      would you do these manipulations?)

Table 11.2 Vowel length manipulation

<table>
<thead>
<tr>
<th>Vowel Length (ms)</th>
<th>[lap] (natural)</th>
<th>[laP1]</th>
<th>[laP2]</th>
<th>[lab] (natural)</th>
</tr>
</thead>
</table>

Q2: Compare the synthesized [lap1] you created with the natural [lab].
   a. How close do they sound?
   b. What further manipulation(s) would make the synthesized and natural tokens more
      similar?
   c. What problems do you find with this way of manipulation?

Q3: Compare [laP1] with [laP2] and the original [lab].
   a. Which of your synthesized tokens sounds closer to the natural [lab]?
   b. How natural are these tokens compared to the natural [lab]? Which ([laP1] vs. [laP2])
      sounds more natural?
   c. What other manipulations do you think might make it sound better?
SECTION II. TONE MANIPULATION

Table 11.3 Tone manipulation

<table>
<thead>
<tr>
<th></th>
<th>Frequency value at the beginning point (Hz)</th>
<th>Frequency value at the end point (Hz)</th>
<th>Duration (ms)</th>
<th>Duration ratio = T4 / T1</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1 (natural)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>T4 (natural)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SyntheticT4_1</td>
<td></td>
<td></td>
<td></td>
<td>T4_1/T1:</td>
</tr>
<tr>
<td>SyntheticT4_2</td>
<td></td>
<td></td>
<td></td>
<td>T4_2/T1:</td>
</tr>
</tbody>
</table>

**Q4:** Compare SyntheticT4_1 with the natural T4.
   
a. How close is it to the natural T4?
b. What else do you think you could do to make it sound more like T4? Think about what other differences there are between T1 and T4...

**Q5:** Listen to SyntheticT4_1 and SyntheticT4_2 and compare them to the natural T4:
   
a. Which synthesized T4 is more similar to the natural T4?
b. What can you conclude from the difference between the two synthesized T4s about the acoustic cues to tone in Mandarin?

REFERENCES

**Q6:** Provide a reference and very brief summary of one academic paper that uses the methods covered in this lab.